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STEP1 »Download TemplerFX Trader by clicking this link.

STEP 2
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OWNLOADING TEMPLER FX TRADER

STEP 3  »Tick "Yes" to continue. Then press the Next button..

Tem

»Run the templerdsetup.exe file the same way you launch any Windows program.

’
{3 Templer FX Trader Setup (32 bit)

METAQUOTES SOFTWARE CORP, -
End-User License Agreement 3
for Trading Terminal g

Flease read the terms and conditions of this Agreement carefully before continuing with
the product install. In this Agreement, unless the content otherwise requires the
capitalized terms used herein shall be defined as set forth in paragraph 1 of this
Agreement.

This Agreement, as well as any updates hereof, constitute a legal Agreement between
You and MetaQuotes Software Corp. and govern the use of the Product on any computer
where it shall be installed, either by You or third parties. MetaQuotes Software Corp. is a
software development company and does not provide or offers any kind of finandal,
investment, brokerage, trading and data feed services in any local or international
currency or stock market,

[ Yes, 1 agree with all terms of this license agreement

Templer Holdings Management, Ltd

Settings Mead =

pler FX Trader setup: Installation in Progress

{3 Templer FX Trader Setup (32 bit)

@ BSIS Tested .Trusted.Templer.

Installation progress

/" Select best access point: https:/fapil.mgl5.com, 103 ms
" Download files
32238Fb

QOur platform is valued not only for its convenience but also for a variety of
services offered.

Subscribe to signals of successful traders, download programs from the online
store or the source code library, hire freelancers to implement your application
development projects and join the sodal network of traders,

Visit the community of traders at www.mql5. com!

Templer Holdings Management, Lid
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FIRST LOGIN TO TEMPLER FX TRADER

B LOGIN TO TEMPLER FX TRADER

To start your Templer FX Trader platform, simply click on the TemplerFX icon that appears on your

desktop.

If you're a first-time Templer FX Trader user you'll be prompted to fill in your username and

password. You received your username and password by email after you completed the registration
process.

Loagir: |
Password:

Server:  Templer-server, templerfi, com

Save account information

Login J | Cancel




TEMPLER

www.templerfx.com

B CHANGING THE LANGUAGE

If you wish to change your language of operation, simply click the view menu tab and choose the
Language option. After choosing your preferred language, restart the Templer FX Trader platform.

File | View | Inget  Charts  Tools Window  Help
Eﬂ- | Languages | v English ‘
E k Toolb ; Vietnamese
oolbars
Turkish
Marks o Siopus Bar I
Swedish
MY o Chars Bar pe
3 U Spanish
o ci[%s] Maret Watch  CirteM i
|4 E {:} Data Window Cid+D Serbian
&+ U % Navigator Ctr=M Fhisdan
[¥ U ;
-ﬁ- Teminal Curt+T Portuguese (Brazil)
e i), Strategy Tester Cid+R Polish
aEl lis
o Bl [c7] Full Screen F11 Mongolian
| 4+ EURL... 12894 1.2397 Lithuanian
& EURIPY | 12071 12035 L gtwian
| % GBPC.. 14575 14585 Korean
& CADIPY 86.43 56.49
| Japanese
& GBPIPY 13590 136.00 -
¥ AUDN... 13276 13288 R
|4 AUDC.. | 1.0114 1.0124 Indonesian
& AUDC... 09380 09338 Hungarian
|| Symbals | Tick Chart | L S
'Navigator x e
|E| MetaTrader Geman
----- @ Accounts French
2 =1 E
J‘ Indicators : Farsi
‘% Expert Advisors )
[%) Custom Indicators o
- i Scripts Dutch
Danish
Czech
Croatian
Chinese (Traditional)
Chinese (Simplified)
Bulgarian
Arabic

B CHANGING YOUR PASSWORD

In order to maintain a high level of security, it is important to change your password from time to time. In
order to change your password, click on the Tools menu and choose Options. After clicking on the Change
button, a new window will open. In this window you can change your password.

-\
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[T Enable prowy server

Keep personal settings and data at startup
[] Enable DDE server

Enable news

After clicking on change you will be able to change your password:

=

o
i

Change Password : I. ? ﬂh,l

i
oF ?_E Password must be complex enough, at least five symbaols long and at least two of
|7 ; the three character types present - lowercase, uppercase, digit

Login: | O

Current password: | must be the master password

(@ Change master password

(") Change investor {read only) password

Mew password: Confirm:

[ oK J [ Cancel ]

B FORGOT PASSWORD

If you have forgotten your password, please contact your Account Manager or support by
email (support@templerfx.com), Live Chat or phone (+44 20 33557076).
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TRADING WITH TEPMLER FX TRADER

B CHOOSING TRADING INSTRUMENTS

Market Watch Window (Instruments Window)

The Market Watch window is where you can see your chosen instruments and their quotes. To open the
Market Watch window click CTRL M or access it from the View tab and choose the item called: Market Watch.

Fle | View | Inset Chats Toolz Wind
[k Languages N =

k Toolbars » A
._Na'_..rig v  Status Bar
% : v Charts Bar
&4
Market Watch ~ Ctrl+M
€3 DataWindow  Cid+D
...'ﬂ
fﬁf Navigator Ctl+M
Teminal Cird+T
f¥) Strategy Tester Cirl+R
[ Full Screen F11

After choosing / adding the Market Watch window, it will appear in the left side of your platform:
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Market Watch: 16:24:53

Symbol Bid Ask *
9 USD... 0.8921 0.8925
i GEBP... 1.6339 1.6342

4 EUR... 1.4451  1.4453

i USDIPY 8319 83.22

% USD.. 0.9620| 0.9624 |=
i AUD.. 1.0515 1.0518

4 EUR... 0.8843 0.3846

% EUR... 1.3736 1.3748
4 EUR... 1.2894  1.2897

s EURIPY | 12021 120.25

% GEP.. 1.4575 1.4585
s GEPJPY | 13590 136.00

4 AUD.. 1.3276 1.3288
& AUD.. 1.0114 1.0124

& AUD.. 0.9380 0.9388

& AUD.. 8747 8753

& CHFIPY 93| 93.27

% EUR... 1.8245 1.8257

9 EUR... 1.3001 13209 _
Mawigator =

Templer FX Trader
.55 LAccounts

EURUSD, H4

EURUSD,H4 1.3679 1.3685

1.3677 1.3684

l‘++Lﬂ‘T*'¢¢Dl+l!

USDCHF, H4

USDCHF, H4 0.5021 D.59025 .5018 §.9019

};{,I,H” Hl]h{h]”“|‘}1+H1*{1|
i d ﬂil
T

Hl:’l{fnq{]‘mwn{
l. i

’ml

Adding / Removing Instruments
To add or remove instruments from the Market Watch window, simply right click anywhere in the window
and choose the Symbol option.

4 AUDC... | 1.023..| 1.024...
& AUDC.., | 0992, 08993..
4 AUDJPY 814258 81478
! aRHE E Mew Order
% ELURM... 1 L Chart Wind
art Window
% EURL... 1 +*
& ADC. | O wr|  Tick Chart
¥ NIDJPY | § Hide
|_Symbols [ Tic Hide Al
Mavigator Show Al
MetaTrau:Ie| PR
_@J Accou! L
L. & 579 Sets
- £ Indicat —
15 Expert e
+ ﬂ} Custon Time
+ ) SCFiptS v Auto P‘.I'IEI'IQE
v  Gd
E Popup Prices
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A window will open with instrument groups which you can choose from. From this window you can add
or remove instruments from Market Watch.

% Templer F¥ Trader
-

. E"I Indexes
&=-(@8 CFD

For Example: in the Forex group, you will ind the major currency pairs - you can choose which pairs you
want to appear in the Market Watch window.

|_:_| Farex

[#] AUDCAD (Australian Dollar vs Canadian Dollar)
|§| AUDCHF (Australian Dollar vs Swiss Franc)
IE AUDIPY (Australian Dollar vs Japanese Yen) L
|§J AUDNZD (Australian Dollar vs Mew Zealand Dollar) 1
IE AUDUSD (Australian Dollar vs US Daollar)
|§| CADCHF (Canadian Dollar ws Swiss Franc)
[ CADIPY (Canadian Dollar vs Japanese Yen)
|§J CHFIPY (Swiss Frank vs Japanese Yen)
IE EURALD (Euro vs Australian Dollar)
|§| EURCAD (Euro ws Canadian Dollar)
IE EURCHF (Euro vs Swiss Franc)

|%| EURGBP (Euro vs Great Britain Pound )

I

The yellow marked pairs are the ones that are visible in the Market Watch window. To remove a pair you
simply choose the pair and click on the Hide button.

The grey marked pairs are the ones that are not visible in the Market Watch window. To add a pair, choose
the pair you want to add and click on the Show button.

N 7
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B OPENING/CLOSING POSITIONS

Open a New Position

To open a new position, simply double-click the Instrument you wish to trade with and it will open a new
Order Window. If you cannot see the Market Watch window, simply activate it by going to the View tab
and clicking on Market Watch.

Market Watch: 12:55:51 %
I Symbal Bid Ask =
4} USDCHF | 0.85713| 085743 |E|
.ﬁ} GBPUSD = 1.57838 1.57868
¥ USDIFY T8.527 78557
"-} UsDCaD | 095741 095781
.ﬁ} AUDUSD | 1.03701 1.03741
"-} EURGBP | 0.79456| 0.794%96
.4} EURAUD | 1.20910| 1.21000
"-} EURCHF | 1.20075| 1.20115
.'4} ELIRJFY 98.514| 95.554
4} GBPCHF | 1.51070| 1.51150
.4} CADJPY 79497 79.557
"-} GEPRIFY 123945 124.015
.ﬁ} AUDNZD | 1.23601 1.25301
"-} AUDCAD | 1.02387 1.02487
.4} AUDCHF | 0.99240 099340
"-} CHFIFY 82016 &2.076
.'4} EURMNZD | 1.55569| 1.55769
4} CADCHF | 096880 096980
.4} MZDJPY 63.262( &3.332
"-} NZDUSD | 0.80570| 0.80610
:ﬁ} GEPAUD | 1.5M46| 152736 .

After double-clicking the instrument you wish to trade, an Order Window will open:
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Symbal: |EURUSD, Euro vs US Dallar

Volume: 1,00

Stop Loss: 0.00000 Take Profit: 0.00000 5

Comment:

Type: lInsEnt Execution

Instant Execution

1.25392 [ 19590

el | | Buy

[7] Enable maximum deviation from guoted price

Maximum deviation: |0

In the Order Windows you have the following fields:

Symbol: Here you can choose the trading instrument you wish to trade.

Volume: Choose how many lots you wish to buy from the specific instrument. Each instrument has a
default Lot size.In the above example, the EUR / USD pair is the chosen instrument which has a default lot
size of 100,000 and the chosen volume is 0.01 lot (which equals 1,000).

Stop-Loss (optional): Choose a stop-loss price in which you wish to exit your trade.

Stop-Loss Orders are used to limit the trader's losses if the market moves against their position.
The trader sets the maximum amount (in terms of pips) that he or she is willing to lose on a
certain trade. When that specified price is reached, the position is closed automatically.

Take Pro it (optional): Choose a take profit price in which you wish to exit your trade.

Conversely, Take Profit Orders are used to lock in the trader’s profit if the market moves
favorably. The trader sets - in advance - the price at which he or she wants to close his or her
position.
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Comment (optional): Write a comment for a specific trade:

Type: There are two types of trades:

1. Instant Trade - opens a position instantly

2. Pending Order - opens a future position in a desired price (see Pending Orders section)

To trigger the trade, after filling the order according to the above fields, simply click on the Buy / Sell.

EURUSD Symbol: |EURUSD, Euro vs US Dollar

1,25454
1.25452 Volume:  1.00

1.25445 Stop Loss: 0.00000

Comment:
1.25440

Type: |Instant Execution

125435
Order Execution

125418

Take Profit:

0.00000

e #6671710 sell 1.00 EURUSD at 1.25417
successful

-
i

1.25412 oK ]

[

Print

1.25401

The position is now listed in the Trade tab of the Terminal window.

Close an Existing Position

In order to close a position, double-click the position listed in the Trade tab of the Terminal window.

L2405 You can print out this information by pressing "Print™ button.

Type
buy
buy

sell

sell

Size

0.01
0.01
0.01
001

Symbol

eurusd

audusd

gbpusd
usdjpy

2 Order Time
Ea 8614995 2012.08.25 12:00
Ea 08615012 2012.08.23 12:00
Ea 85615019 2012.08.23 12:00

E [a 08615022 2012.08.23 12:00

E’ Trade | AccountHistory | Alerts | Mailbox | Experts | Journal |

MNavigator page

This will open the position you wish to close.




TEMPLER

www.templerfx.com

Order #6615012 buy |
AuUDusD Symbol: | AUDUSD, Australian Dallar vs US Daollar vl
1.03748 Volume: 0.01 -
103743 Stop Loss: 0.00000 (5 Take Profit: 0.00000 (5
Comment:
1.03737
Type: [Insbnt Execution -
1.03732
Instant Execution

1.03710 / 1.0375
1.03721 - -
1.03716 [ e J [ i) ]

[ Close #6615012 buy 0.01 AUDUSD at 1.03710 |

[7] Enable maximum deviation from quoted price
1.03705

Maximum deviation: | 0 pips

1,03700

Click on the Close Order button which appears under the Buy / Sell buttons.

Partial Closing of a Position

When closing an exisiting position, you have the option to close part of the position and not all of it.
For Example: if you bought 1 Lot of EUR/USD and wanted to sell 0.7 lots (keeping 0.3 lots open), you
simply choose the amount you wish to sell (0.7 lots) in the Volume field and then click Close.

B  MODIFY AN EXISTING POSITION

To modify an existing position, double-click the position in the Trade tab.

= Order ¢ Time Type Size Symbaol
Ea 8614995 2012.08.25 12:00 buy 0.01 eurusd
[a 68615012 2012,08.2312:00 buy 001 gudusd
[a 8615019 2012.08.23 12:00 sell 001 gbpusd

23 es15022 2012.08.23 12:00 sell 0.01 usdjpy

E Trade | AccountHistory | Alerts | Mailbox | Experts | Journal |

MNavigator page

After double-clicking the position, in the Position Window, click on the Type drop-down list and choose
Modify Order.
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Order #6615022 sell 0

Symbel: [USDIPY, US Dollar vs Japanese Yen

Volume: | 0.01
Stop Loss: : Take Profit:

Comment:

Type: [Modiﬁa Order

Modify Order

Level: 80 ¥ points Level: 80 *  points

Copy as: 78.6356 i Copy as:

-

Stop Loss: 0.000 = Take Profit: 0.000 -

Modify #5615022 sell 0,01 USDIPY sl: 0.000 tp: 0.000

Stop Loss or Take Profit you set must differ from market price by at least 80 pips.

Modify your order and click Modify.
B PENDING ORDERS (ENTRY STOP / ENTRY LIMIT ORDERS)

Pending orders, also known as Entry Stop and Entry Limit Orders, are orders which are triggered open
when the market reaches a desired market price.

There are 4 different types of Pending Orders (Entry Orders):
» Entry Limit Buy
An order to open a Buy position at a lower price than the price at the moment of placing the order.

» Entry Limit Sell
An order to open a Sell position at a price higher than the price at the moment of placing the order.

» Entry Stop Buy
An order to open a Buy position at a price higher than the price at the moment of placing the order.

» Entry Stop Sell
An order to open a Sell position at a price lower than the price at the moment of placing the order.

e L
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This illustration explains how to use the above Entry orders:

Buy stop Sell fimit |
> < ]

| |
.|1|M .Jllm

'| |
I|||l“ ’I]Hh

Buy limit i1 Sell stop
<& L

In order to place a Pending Order, open the Order Window by double-clicking the instrument you wish
to trade in the Markets Watch window.
Then choose the pending order item from the drop down list related to the Type field:

" Order #6615022 sell 0

Symbol:  [USDIPY, US Dollar vs Japanese Yen

Volume:  0.01 -

Stop Loss: g = Take Profit:

Comment:

Type: ’Pending Order

Pending Order

Type: |Buy Limit > | USDIPY 0.01

Buy Stop

Sell Stop

at price:  Sell Limit ‘[
Expiry: [ rwrmmorrorrTorTe—w

Open price you set must differ from market price by at least 80 pips.

Fill in the Volume, Stop-Loss and Take Profit fields as you would when opening a regular position.

e Qe
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In the Pending Order Box, choose the type of pending order you wish to execute:

1. Buy Limit (Entry Limit Buy)

2. Sell Limit (Entry Limit Sell)

3. Buy Stop (Entry Stop Buy)

4. Sell Stop (Entry Stop Sell)

After choosing the order type, choose the rate you wish to enter the trade and the expiration date of the order.

This is done in the At Price field and Expiry (Expiration) field.After filling all above fields, click on the Place
button to place your pending order.

Modifying a Pending Order

To modify a pending order, simply click the pending order which appears in the Trade tab in the Terminal
Window. In the order window that opens, you can now modify the price you wish to enter the trade as
well as the stop-loss / take profit fields.

B  USING MT4 CHARTS

How to Open a Chart on MT4?
In the Market Watch window, right click on the wanted instrument and choose Chart Window.

‘4} EURUSD | 125466 1.25496 [
78530] 7 New Order F9

4 USDCAD | 0.98745 0. E-.JT}- Chiast Whrnclow
¥ AUDUSD | 1.03703| 14—
[or]  Tick Chart Space
4 EURGEP | 0.79433 0.
4 EURALUD | 1.20932 1 Hide Delete
¥ EURCHF  1.20075 1 Hide Al
0
& EURJPY | 98.538 ¢ b
# GBPCHF | 151115 1.
Symbols
4 CADIPY 79497 3
Sets »

& GBPIPY 124012 13
< AUDNZD | 1.28662 1. High/Low
& AUDCAD | 1.02395 1.

Time
4 AUDCHF @ 099223 0.
v Auto Amange
4 CHFIPY 82036 8
v Grid

4 ELURNZD @ 1.55672 1.
% CADCHF | 0.96855| 0. a Popup Prices F10
o MNZDIFY 63,236 G308 |

-\
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A Chart window, with the chosen instrument, will open.

Types of Charts
MetaTrader 4 allows you to choose between three different chart types:

» Line Chart
» Bar Chart

» Candlestick Chart

Line Chart

The Line Chart is the most basic type of chart. The line shown in the chart connects single prices over a
selected period of time. The most popular Line Chart is the daily chart. Although any point in the day could
be plotted, most traders focus on the closing price, which they consider the most important; however,
this presents an immediate problem: when using a daily Line Chart, one cannot see the price activity that
occurred during the rest of the day.

) EURUSD,H1 o [ =] &R

EURUSD,HL 125445 1.2546
luﬁﬂ’

P|||[]||| IrIIII|||‘”||_

||||||,]‘ |n.|||| Lo : B U PR SN i,_ "

IU 1“ ||||Jn

|||'I|'|| ‘||II||I,III|||||| L|I| " ||]'|| N‘ ‘ll T

Bar Chart

Each vertical bar represents one period of price activity from the chosen period, which could be as short
as 1 minute for intraday charts or as long as several years for historical charts. On a daily chart, the vertical
bar represents one day’s trading whereby:

®  The top of the bar represents the market’s high price

= The bottom of the bar represents the low price

e Gt
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®  The left hash mark on the bar indicates the opening price

= The right hash mark on the bar indicates the closing price

USDIPY, Ha = | &[]

| USDIPY,H4 78,58 7B.55 78.51 TB.S5. T S i S T S i P i R e e T Lo Y79as

Candlestick Chart

The Candlestick Chart is closely related to the Bar Chart, as it also represents the four major prices: high,
low, open and close. Each candle represents a timescale of your choice. The following timescales are
offered by different chart software:

1 min, 15 min, 30 min, 1 hour, 2 hour, 4 hour, 8 hour, daily, weekly and monthly.

For example, in the below 4 hour chart, each candlestick represents 4 hours of trading range and is
displayed as “open” or “closed”.

USDIPY, H4 =

) 10 Aug 12:00 00 13 Aug 16:00 14 Aug 08:00 15 Aug 00:00 ) 16 Aug
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= An open candlestick represents a higher close than open and is shown in blue.

® A closed candlestick represents a lower close than open and is shown in red.

Each candlestick consists of two components (the real body and the shadows):
®  The real body is the thick part of the candlestick that represents the open and the close.

®  The thin lines above and below the real body are the shadows that represent the session’s price
extremes.

®  The upper shadow (above the real body) measures the high of the session and the lower shadow
(below the real body) measures the low of the session.

MT4 CHART FUNCTIONALITIES
After opening a desired chart there are many chart features that the MT4 platform offers. These features
can be found in the Chart Toolbar and the Periodicity Toolbar.

File | View | [mset Chats Tools Window  Help
IQ. Languages r P"ﬂ I% Mew Order i”?"
L3 | Toolbars v  Standard
Marke Status Bar v | Charts
Sl Charts Bar v  Line Studies
+ U = e
v | Perod
2 cl[®] Maket Watch  Ci+M ronicia
Data Window Cid=D Customize. ..

Mavigator Cirl+M
Teminal Cirl+T

* Al Strategy Tester Cid+R

& E|
4 El

b
o)
O PO R < <

Full Screen F11

After choosing the above toolbars, they will appear in the upper bar.

B PERIODICITY TOOLBAR

M1 ME MIE M0 H1I [ H4 D1 w1l MM

With the Periodicity Toolbar, you can choose the timescales of your chosen chart.

M1 1 Minute Chart M30 30 Minute Chart D1  Daily Chart
M5  Minute Chart H1 1 Hour Chart W1 Weekly Chart
M15 15 Minute Chart H4 4 Hour Chart MN  Monthly Chart

. 7
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B CHARTTOOLBAR

i elaae kg 0 B

The chart toolbar offers a lot of functions, such as:

1. Choosing between chart types:

a. Bar Chart 14,
b. Candlestick Chart 18
c. Line Chart K

2. Zooming in and out on a specific section in a chart
3. Adding different technical indicators to your chart (see image below):

Loplaae kg 08

Accelerator Oscillator

e e I Accumulation/Distribution
[ = [ =] & | | G GBPUSD,H

Alligataor
GEPUSD,H4 1.

Awerage Directional Movement Index
#E£10019 s=ll Average True Range
1.25420
Awesome Oscillator
Trend
Qzcilators
Volumes

Bill Williams

Custom

18








